Getting Started with
Apple iOS Devices

A guide for using iPad, iPod touch, and iTunes
for K-12 teaching and learning



Getting Started with Apple iOS Devices:
A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Contents

Page4  Foreword

Page6  Overview
6  About iOS Devices and iTunes for Education
8  Why iPad, iPod touch, and iTunes for Education?

Page 10  Finding and Using Education Content for iPad and iPod touch
10  Finding Content on iTunes U
12 Adding Apps from the App Store
14  Reading Books on iPad and iPod touch
15 Locating and Listening to Audiobooks
15  Subscribing to Podcasts
15 Locating Movies, Music, Speeches, and Other Media

Page 16  Creating Your Own Content
16  Producing Digital Content with iLife
17 Producing Podcasts
18  Making Movies with iPad and iPod touch
19  Making Music with GarageBand on iPad
19  Using iPod touch and iPad for Voice Recording
19 Creating and Sharing Presentations
20 Creating and Sharing ePub Documents
21 Using iWork on iPad

Page 22  Using the Apps Included with iPad and iPod touch

22 Videos
22 Camera
22  Photos
23 Safari

23 Notes

23 Mail

23  Calendar
24  iBooks
24  FaceTime
24  Contacts
24  Settings
24  Maps

24  iPod (oniPad)

25 Music (on iPod touch)

25 Photo Booth (on iPad)

25  Calculator (on iPod touch)
25  Clock (on iPod touch)

25 Voice Memos (on iPod touch)



Getting Started with Apple iOS Devices:

A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Page 26

Page 28
28
29
29
29

Page 31
31
31
32
34
34
36
36
36
37

Page 38
38
38
39
39
40
40
40
1
1
42

Page 44
44
46
46

Adding Content to an iOS Device Using iTunes

Accessibility and iOS Devices
Vision

Hearing

Physical and Motor Skills
Apps for All Learning Styles

Managing iOS Devices and iTunes for Student Use
Getting Students Up to Speed

Managing iPad and iPod touch in the Classroom
Setting Up Student Groups and Accounts

Volume Purchase of iOS Apps

Managing Settings on iOS Devices

Keeping Track of Student iOS Devices

Sharing iOS Devices

Mobile iOS Learning Solutions

Restricting Access with Parental Controls

Enhancing Classroom Learning with iOS Devices and iTunes
Increasing Language Skills
Improving the Written Word

Building Reading Fluency

Learning World Languages
Increasing Reading Comprehension
When and Where in the World

Mobile Math

A Deeper Look at Science

Exploring Art and Music

Enhancing Productivity for Educators

Resources

Apple Websites

Additional Websites

Accessories for iPad and iPod touch

© March 2011 Apple Inc. All rights reserved. AirPlay, Apple, the Apple logo, FaceTime, GarageBand, iCal, iDVD, iLife,
iMovie, iPhone, iPhoto, iPod, iPod touch, iTunes, iWork, Keynote, Mac, MacBook, Mac OS, and QuickTime are trademarks
of Apple Inc, registered in the U.S. and other countries. iPad, iWeb, and Multi-Touch are trademarks of Apple Inc. iTunes
Store is a service mark of Apple Inc,, registered in the U.S. and other countries. App Store and MobileMe are service
marks of Apple Inc.

Some applications are not available in all areas. Application availability and pricing are subject to change. Wi-Fi Internet

access required for some features; broadband recommended; fees may apply.

The iTunes Store is available only to persons age 13 or older in the U.S. and many other countries; see
www.apple.com/support/itunes/ww for a list of countries. Requires compatible hardware and software, and Internet

access (fees may apply). Terms apply. See www.apple.com/itunes/whats-on for more information. L337788C


http://www.apple.com/support/itunes/ww
http://www.apple.com/support/itunes/ww
http://www.apple.com/itunes/whats-on
http://www.apple.com/itunes/whats-on

Getting Started with Apple iOS Devices: 4
A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Foreword

Educators all over the world are examining the methods, tools, and learning
environments required to develop the 21st century skills our students need to succeed
in their schools, workplaces, and civic lives. Many educators are already achieving great
results using mobile devices, such as iPad and iPod, in their classrooms. Teachers are
using the flexibility of iOS devices to support second language learners, address the
unique learning needs of diverse learners, motivate struggling readers, as well as to
support their own professional development. And, because iPad and iPod are portable,
teachers and students can learn where and when they want.

iPod and iPad make it possible to deliver large quantities of content—such as
comprehensible language—to students in an efficient and convenient manner. Today,
one out of every five K-12 students in the United States comes from a home in which a
language other than English is spoken. This situation presents additional challenges for
educators. Using iOS devices with iTunes, teachers can enhance audio with pictures and
video, making important visual connections to the second language being learned.

Teachers and students can also use the iLife suite of digital authoring applications
included on every Mac, such as iMovie and GarageBand, to create their own content for
iPad and iPod. They can also use Pages, one of the applications in iWork, Apple’s suite of
productivity applications, to easily develop ePub documents for iPad and iPod touch.
The combination of Apple iOS devices and iLife and iWork software is a great way for
educators to create, organize, and distribute content, adding new and exciting
dimensions to learning. And iTunes provides an easy way to store, organize, and
purchase content for iPad and iPod touch.

The seamless integration of Apple’s iOS devices and iTunes makes it easy for teachers to
provide textual, auditory, and visual resources to reach all types of learners, particularly
those students who need extra assistance. Using iPad and iPod touch in the classroom
can help students master content standards.

Capturing the attention of today’s students can be challenging, and using iPod or iPad
with audiobooks or book apps is yet another way to get students engaged in learning.
These books motivate and create interest in the physical texts themselves. Audiobooks
and book apps can be readily used with iPad and iPod—using them in this way is like

having a model reader with the student at all times.

And with iPad and iPod touch—with their built-in Wi-Fi capabilities and Safari web
browser—students can access the Internet, take notes, keep track of their calendars,
communicate via email, blog, and even utilize a scientific calculator. They can also access
thousands of educational applications in the iTunes App Store for learning math skills,
science concepts, grammar and vocabulary, a second language, world geography, and
much more. Many schools are discovering the power of giving all students access to an
iPad or iPod touch and are seeing how having iOS devices literally at students’ fingertips
transforms teaching and learning. Educators are discovering that the use of these
devices in the classroom puts students in charge of their own learning in ways not
possible before.
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What about the many administrative functions you must perform and keep track of as
an educator? iPad and iPod touch are also wonderful devices to help you to organize
and manage routine tasks. You can keep your calendar, contacts, and notes on an iPad or
iPod touch as well as record voice memos to yourself or audio assessments of your
students. Need to research something or find directions to your next meeting? iPad and
iPod touch allow you to quickly access the Internet from a Wi-Fi connection. Have a
presentation to give? You can use Keynote to develop and present your content right
from iPad. Depending on your student information system, you can even take
attendance and complete your grades right from your iPad or iPod touch.

This Getting Started guide is designed to help you create an environment where
learning really is anywhere, anytime. You'll learn the basics of iPad, iPod touch, and
iTunes so that you'll be familiar with their operation and interface. Whether for one user
or an entire class, you'll also discover how to effectively set up, maintain, and manage
iOS devices in the classroom. You'll even explore several curriculum ideas for using iPad
and iPod touch as a part of creating a 21st century learning environment in your
classroom. Because Apple products have a similar, easy interface, it won't take you long
to begin using these innovative tools with your students.

The power to effectively teach and learn is in the hands of you and your students, both
literally and figuratively, when you use Apple’s iPad, iPod touch, and iTunes in your
classroom.

Kathy Shirley

Technology and Media Services Director
Escondido Union School District
Escondido, California
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Overview

About iOS Devices and iTunes for Education

As many educators have discovered, iPad, iPhone, and iPod touch are easy-to-use iOS
devices with a variety of uses for the classroom. (They're called iOS devices because they
use the Apple iOS operating system.) Students are using iOS devices to view educational
videos, listen to audio recordings or podcasts, view primary source images, and do
research on the Internet. And with the productivity apps that come with iPad and iPod
touch, you and your students can send and receive email, take notes, keep calendars
and contact files, and much more.

With iPad 2 and iPod touch (4th generation), students can also take photos, use
FaceTime to take part in video chats, and even make HD movies on the go with the
built-in camera. With iWork apps for iPad (available from the App Store), they can create
presentations, many types of documents, and spreadsheets.

And by choosing from thousands of education apps available for download from the
App Store, teaching and learning is expanded even more. Students can view the stars,
learn a language, review math facts, practice vocabulary and grammar skills, and learn
about historical events. With iPad and iPod touch, you can copy and paste from app to
app, such as text from a webpage to a note. You can even connect the devices to a TV or
projection device with an added accessory (see “Accessories for iPad and iPod touch”
later in this guide) to display slide presentations and other content. And when you
connect an iPad to a HDTV or projector with the Apple Digital AV Adapter or Apple VGA
Adapter (sold separately), the class can see everything that’s on your iPad display with
what's called video mirroring.
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Loading files, apps, photos, songs, and video content onto iPad and iPod touch is
simple. The dock connector on the bottom of the device lets you connect your device to
a Mac or PC with the included USB cable, and then you can use iTunes to organize your
content and sync (copy files onto the device), and recharge quickly. With the iPad and
iPod touch and a Wi-Fi connection, you can also download media and apps directly to
your device.

This guide focuses on iPad and iPod touch and their capabilities. Note that this guide is
based on iPad 2. If you have the earlier version of iPad, certain features discussed will not
apply, such as Camera, FaceTlme, Photo Booth, iMovie, and video mirroring.

If you are determining whether to use iPad or iPod touch with your students, evaluate
your students’ needs and your plans for the devices' use. For example, the smaller size of
the iPod touch may be an advantage for learning on the go, for younger students with
smaller hands, or for use for language acquisition. Or you may choose iPad when
students will benefit from the larger screen size or will be creating content with iWork.
The other models of iPod also provide versatile tools for the classroom environment:

iPod classic: Provides access to audio, video, photos, and more, with a very large amount
of storage capacity.

iPod nano: Compact-sized with access to audio, video, and photos; includes a Multi-
Touch screen and VoiceOver for hearing navigation information aloud.

iPod shuffle: Small-sized iPod that offers access to audio files and also includes VoiceOver
for hearing items read aloud.

For detailed information about the specifications of each iPod model, including hard
drive size, battery duration, and included accessories, visit www.apple.com/ipod.

iTunes at a Glance

iTunes is an application for organizing and playing digital audio and video content. It
has an easy-to-use interface for managing the content on iPad and iPod. You can set up
iTunes so that when an iPad or iPod touch is connected to a computer, the iTunes library
is automatically synced to that device.

iTunes is also used to connect to the iTunes Store for downloading free academic
content from iTunes U, apps from the App Store, podcasts, music from around the
world, audio and digital books, full-length movies and TV shows, speeches, and more.
With Apple TV, the contents of an iTunes library, such as movies and TV shows, can be
viewed on a classroom television. iTunes is compatible with both Mac and PC and
comes pre-installed on every Mac computer. It is available as a free download at
www.apple.com/itunes/download.

Adding content to your iTunes library is as easy as downloading it from the iTunes Store
or importing it from a CD. The iTunes library can hold a collection of digital audio and
video files, such as music from a CD, video files downloaded from iTunes U, apps
downloaded from the App Store, and iBooks purchased from the iBookstore. As an
iTunes collection grows, you can maintain multiple libraries for classroom use.

Using iTunes, you can organize songs and other items into lists called playlists. Files are
not duplicated each time you place them in a playlist. They are simply aliases, or
pointers, to the actual files in your iTunes library. The sidebar displays all the playlists in
the iTunes library.
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You can create your own playlists to organize the content in iTunes in the best way for
you and your students, such as a playlist for a specific student project or for a particular
class. For example, if the class is studying the American Civil War period, you could
create one playlist with songs from that time period and video clips from iTunes U.

You can also create Smart Playlists that automatically update according to criteria you
set—for example, podcasts you've added in the last month. You can also use playlists to
set up digital portfolios for students to collect and assess their work throughout the
school year.

From the iTunes window, you go to the iTunes Store by clicking iTunes Store in the
sidebar when you are connected to the Internet. As you download free or purchased
items, iTunes automatically adds the items to your library.

With the Parental Controls feature of Mac OS X, you can choose to restrict students’
access to the iTunes Store or to explicit content from the iTunes Store. (You can allow
access to iTunes U content even if access to the iTunes Store is restricted.) See
“Restricting Access with Parental Controls” later in this guide for more information.

To learn about the settings in iTunes for an iOS device, see “Adding Content to iPad or

iPod touch Using iTunes” later in this guide. For links to more detailed information about
iTunes, see the “Resources” section later in this guide.

Why iPad, iPod touch, and iTunes for Education?

Innovative educators are using iOS devices and iTunes as powerful educational tools to
meet students’ academic needs and to help them achieve 21st century literacy. Here are
just some of the reasons:

iPad and iPod touch, like Apple’s other iOS devices and computers, are familiar, easy-to-
use, and exciting for students. And the Multi-Touch screen of iPad and iPod touch means
students can read a book, explore an app, page through websites, and much more with
just the touch of a finger.

The devices’ portability, instant “on,” and long battery life give students anytime access
to learning from any location.

iPad and iPod touch can be personalized to meet students’ individual learning styles and
needs such as with customized playlists, accessibility features, Parental Controls settings,
support for 30 languages, and specific educational apps. And students can also access
content as many times as necessary until the content is mastered.

Students are engaged with their education with iOS devices—they actively participate
in and focus on the learning process, no matter what their learning style.

Whatever the subject, iTunes U offers invaluable education content in videos, podcasts,
audiobooks, PDFs, and more, from around the world and all free of charge.

With a Wi-Fi connection, students have anytime access to the Internet as well as to
printers on the wireless network. Bluetooth devices mean connection with a wealth of
other tools, such as digital microscopes, science probes, and keyboards.

Education apps from the App Store offer limitless avenues for exploring new subjects,
reinforcing learning, expressing creativity, helping with organization, and much more.

iPad and iPod touch offer all types of learners versatile and amazing ways to read—from
reading with iBooks with its access to a dictionary and other tools with a tap of the
finger, to a wealth of audiobooks, as well as textbooks and other interactive book apps.
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Students and educators have a valuable collection of productivity tools in just one
device—for taking notes, keeping track of dates, browsing the Internet, sending and
receiving emails, for just a few examples.

With built-in features and apps from the App Store, iPad and iPod touch offer a broad
range of accessibility tools to address students with special needs, such as visual and
auditory impairments.

These are just a few of the reasons educators are finding iPad and iPod touch so
valuable for teaching and learning with today’s students. The rest of this guide offers
information and suggestions for their use in your classroom.
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Finding and Using Education
Content for iPad and iPod touch

iOS devices and iTunes provide a great way for you and your students to access valuable
educational resources. This includes content from existing sources, such as apps, iBooks,
podcasts, audiobooks, music, and videos, as well as content they create themselves, such
as podcasts, movies, photos, slide presentations, and ePub documents.

This section describes different types of education content and apps that are available
for use with iOS devices. The next section describes how you and your students can use
the tools that come with a Mac and iPad and iPod touch to produce your own content
to use with these devices.

Finding Content on iTunes U

One great resource from the iTunes Store is the comprehensive collection of educational
content in iTunes U, including lectures, lab demonstrations, language lessons, movies,
panel discussions, and more. iTunes U now offers over 350,000 free audio and video
files. iTunes U content comes from hundreds of colleges and universities in 26 countries,
state departments of education, and other education content providers, and includes
content aimed at both Higher Education and K-12 audiences. For example, you can view
and listen to speeches, interviews, technology tutorials, science movies, news reports, art
lessons, and professional development resources of interest to a broad range of
audiences. The Beyond Campus section of iTunes U includes professionally-created
content from cultural institutions such as PBS, NPR, and American Public Media, as well
as from museums, such as the Smithsonian, The New York Public Library, the Brooklyn
Museum, and many more. You can download and play iTunes U content on a computer
or transfer it to iPad or iPod touch for anytime access.

Some specific examples of iTunes U content for use by K-12 teachers and students
include:

Khan Academy—an ever-growing library of videos on biology, algebra, calculus,
chemistry, and many more topics

KQED (a PBS affiliate) —a variety of videos and other education materials for use in the
classroom; topics include Digital Storytelling and The Physics of Baseball

Study Partner from the Tennessee Department of Education—math skills audio
presentations for students in second through eighth grade

Library of Congress—a variety of films, audio, and educational materials, including
primary source historical videos such as Early Films: Edison Companies and America at
Work, America at Leisure.

See “Enhancing Productivity for Educators” later in this guide for more iTunes U
resources for professional development.
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To locate and download resources in iTunes U on a computer:
. Open iTunes, then click iTunes Store (below Store in the sidebar).

. Click iTunes U at the top of the iTunes window to go to the main iTunes U page. (If you
do not see iTunes U at the top of the window, enlarge the window by dragging the
resize control in the bottom-right corner of the window.) Press and hold iTunes U in the
navigation bar to view categories of content or click an option in the iTunes U Quick
Links, Top Downloads, or Featured Provider box. To learn more about iTunes U, click An
Introduction to iTunes U in the Learn More box.

. To search for iTunes U items on a certain topic, enter text in the search field in the upper
right of the iTunes window. The iTunes Store divides the results into categories. Click
iTunes U under Filter By Media Type at the left of the window to see just the iTunes U
items from the search. (If you have restricted students from using the iTunes Store in
Parental Controls, you can still allow them access to search and download items from
iTunes U. (See “Restricting Access with Parental Controls” later in this guide for more
information.)

. Click an iTunes U title at the top of the window to view more information about it and
to see a list of available audio and video tracks. Double-click an item in the list to play it.

. Click Get or Free to download the track or tracks you want. If the content is ongoing, you
can then subscribe to automatically download future tracks for an iTunes U title. Often
transcripts of the audio are available too.

Once downloaded, you can connect an iPad or iPod touch to your computer to sync the
new files to the device.
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To locate and download resources in iTunes U on iPad:

. From the Home screen, tap iTunes.
. Tap iTunes U at the bottom of the screen.

. Tap Universities & Colleges, Beyond Campus, or K-12 to see content from specific

institutions, or browse the Noteworthy content featured on the main screen. To look for
a specific item, type the word you want to search for in the Search field at the top of the
screen, then tap Search on the keyboard.

. Tap an item once to preview it.

. To download content, tap the item, tap the Free button, and then tap Download.

To locate and download resources in iTunes U on iPod touch:

. From the Home screen, tap Music.
. Tap More at the bottom of the screen.
. Tap iTunes U.

. From this screen, browse featured content, see the most popular downloads in specific

categories, or browse additional content by category, such as Fine Arts or Teaching &
Education. To search for a specific item, tap Search at the bottom of the screen, type the
word or words you want to search for in the Search field at the top of the screen, tap
Search on the keyboard, and then scroll down to see the iTunes U items that are found.

. Tap an item once to preview it.

. To download content, tap the item, tap the Free button on the right of the screen, and

then tap Download.

See “Resources” later in this guide for more information about iTunes U.

Adding Apps from the App Store

Many apps, such as Calendar and Safari, come with iPad and iPod touch, as described in
“Using the Apps Included with iPad and iPod touch” later in this guide. You can further
enhance teaching and learning by downloading additional apps from the App Store.
You can choose from an amazing collection of apps, many of which are available free of
charge and are designed specifically for education. Apps are available that can be used
on iPhone, iPad, and iPod touch and there are also apps developed for iPad specifically.
To view an app for iPhone or iPod touch in a larger size on iPad, just tap 2x at the
bottom right of the iPad screen.

You can easily organize apps into folders on iPad and iPod touch. For example, you could
have a folder of math apps and another folder of language arts apps. To use folders, on
the device, touch and hold an app until it wiggles and then drag it onto another app. A
folder is created with those two apps. Repeat this step to put other apps in the same
folder. The folder is automatically named with the category of apps but you can rename
it. To do this, touch and hold the folder until it wiggles (if it's not still wiggling), tap the
folder icon, tap in the field with the folder name, type a new name, and then tap Done.
To access apps in a folder, just tap the folder and then tap one of the apps in the folder.
To remove an app from a folder, touch and hold the folder until it wiggles, tap the
folder, then drag the app with an “x” out of the folder area at the bottom of the screen.
You can also create app folders in iTunes when your device is connected to your
computer.
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Just a few examples of apps that can be downloaded are:

Vocabulary Central from Pearson Education, Inc. (for iPad and iPod touch)—for each
grade from 6-12, an app with engaging flash cards, songs, and trivia games to help
students learn vocabulary words

Encyclopedia Britannica Kids: Ancient Egypt (for iPad and iPod touch)—for ages 8-12 to
learn about Egypt with videos, images, and interactive maps and games. (Volcanos and
Dinosaurs are topics of other apps in this series.)

Frog Dissection from Emantras Inc. (iPad) —scientifically accurate and easy-to-use frog
dissection app

Starfall ABCs from Starfall Education LLC (for iPad and iPod touch)—for younger
students, including English language learners, to see, hear, and interact with letters and
sounds in words, sentences, and games

Math Bingo from ABCya.com LLC (iPad and iPod touch)—lively game to practice
addition, subtraction, multiplication, and division skills that offers choice of three
different levels of difficulty

Time, Money & Fractions from School Zone Publishing (for iPad)—practice in learning
these skills with animated activities for first and second graders; includes audio guides,
instant grading, and progress-tracking

Clicker and eClicker Host from Big Nerd Ranch, Inc. (iPad and iPod touch)—polling
software that can be used to pose questions to the class with eClicker Host that they
answer with eClicker app on their iOS devices

Wolfram|Alpha from Wolfram Alpha LLC (for iPad and iPod touch)—a comprehensive
reference app that provides instant answers to all sorts of questions on any topic

Pearson AlgebraPrep from Modality Inc. (for iPad and iPod touch)—a series of ten apps
for review, practice, and test preparation for algebra; includes practice tests and
instructional videos

The Elements: A Visual Exploration (for iPad) and The Elements for iPhone 4 (for iPod
touch) from Element Collection—visual interactive periodic table app with 360-degree
views of elements and related objects and a wealth of engaging information; iPad
version is 3D viewable with 3D glasses

National Geographic GeoBee Challenge—a fun way to test your knowledge of world
geography; includes beautiful maps from National Geographic

iHomework from Paul Pilone—an organization aid with which students can track
assignments, store class and teacher information, calculate course grades, and set
reminders for themselves

Proloquo2Go from AssistiveWare—an augmentative and alternative communication
(AAQ) system for students who have difficulty communicating verbally

To view a list of additional recommended apps for education, visit www.apple.com/
education/apps.

You can locate and download the apps from the App Store in iTunes and then sync
them to iPad or iPod touch or can download them directly to your device when
connected to the Internet via a wireless network. You can search for apps by category or
by name.

You need an iTunes Store account to download apps from the App Store, including free
items. You can set up this account by clicking Account in the iTunes window. You do not
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need to enter credit card information to open an account. (For more information, go to
http://support.apple.com/kb/HT2534.) Once an app has been synced to iPad or iPod
touch or installed directly, you can open it by tapping its icon.

Educational institutions can purchase multiple copies of apps at the same time by using
the App Store Volume Purchase Program. For more information about this program, go
to http://volume.itunes.apple.com/us/store.

Reading Books on iPad and iPod touch

iPad and iPod touch provide an engaging way for students to read books, whether they
are books from the iBookstore or interactive books from the App Store.

Students can read books from Apple’s iBookstore using the iBooks app, a free download
from the App Store. After you have downloaded the app, tap the iBooks icon and a
bookshelf appears. Tap Store to download a book. Thousands of books are available for
download from the iBookstore, many of which are free. The following are just a few of
the books available for no charge: The Odyssey, Thomas Paine’s Common Sense,
Frankenstein, The Federalist Papers, and Winnie-the-Pooh.

Students just tap to open a book on their iBooks bookshelf and can swipe to turn the
pages of the book. With iBooks, students can easily customize their reading experience.
They can access dictionary definitions, adjust the font size, zoom in on a page, search for
words, highlight text, and add notes. They can also use VoiceOver to have the text read
back to them. (See “Accessibility and iOS Devices” later in this guide for information on
settings that will allow VoiceOver to be turned on and off with a triple-click of the Home
button.)

Students can also read and explore books on iPad and iPod touch with interactive book
apps, such as Milly, Molly and the Bike Ride, Miss Spider’s Tea Party, Shakespeare in Bits:
Romeo and Juliet, and Green Eggs and Ham. There’s also Biology by Raven et al., an entire
textbook now available with the Inklings app for iPad.
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Locating and Listening to Audiobooks

Many students benefit from listening to audiobooks on iPad and iPod touch. A large
selection of audiobooks is available for purchase from the Audiobooks section of the
iTunes Store. In addition, iTunes U includes hundreds of public domain audiobooks
recorded and distributed by the University of South Florida that students can read and
listen to on iPad or iPod touch. If you already have audiobooks on CD in your classroom
or school library, you can import those books into iTunes and then sync them to iPad or
iPod touch.

To locate audiobooks available from the iTunes Store, click iTunes Store in the sidebar in
iTunes. Click Audiobooks in the top menu bar in the main iTunes Store window. The
available audiobooks, such as Lord of the Flies, Macbeth, The Great Gatsby, and The Lorax,
are organized by category. You can also locate audiobooks by entering a title or author

in the search field at the top right of the iTunes window, and then pressing Return or
Enter.

To view the large collection of audiobooks in the Lit2Go collection offered by the

University of South Florida, go to http://itunes.apple.com/WebObjects/DZR.woa/wa/
viewTagged?tag=Lit2Go&id=384490576. Students can view the text of these books

while they listen by tapping the iPad or iPod touch screen when the book is playing.

Students can easily move around audiobooks on iPad or iPod touch. If an audiobook has
chapters, to restart the current chapter, tap Previous/Rewind. Tap Previous/Rewind twice
to move to the previous chapter and tap Next-Fast-forward to move to the next chapter.
When you end a session and return to the book later, the iPad or iPod touch will start
the book where you last stopped reading.

You can set audiobooks to play faster than normal or set them to play more slowly. To
set an audiobook’s play speed, in iPad or iPod touch Settings, choose Music >
Audiobook Speed, then choose Slower, Normal, or Faster.

Subscribing to Podcasts

In addition to the resources of iTunes U, a wide range of other educational content has
been developed for and is delivered via podcasting. With podcasts, you and your
students can subscribe to free audio or video content available on the Internet. Once
you subscribe to a podcast, each new episode gets downloaded to the computer
automatically and then can be synced to the iOS device.

The iTunes Store is one of the best sources for education-related podcasts, with a
section of content for education. You'll find shows produced by students, professional
development materials from other educators, podcasts designed to help with learning a
new language, and podcasts from museums. You and your students can also create and
post podcasts to the iTunes Store. (See “Producing Podcasts” later in this guide.)

To access the library of podcasts, in the main iTunes window, tap Podcasts in the top
menu bar. iTunes displays podcasts you've subscribed to in the Podcasts section in the
iTunes window’s sidebar.

Locating Movies, Music, Speeches, and Other Media

Along with podcasts and audiobooks, you can also use other types of existing content
with iPad, iPod touch, and iTunes. You can browse through the iTunes Store to locate a
variety of other media to enhance your curriculum, such as documentary movies,
television shows, famous speeches, and children’s music.


http://itunes.apple.com/WebObjects/DZR.woa/wa/viewTagged?tag=Lit2Go&id=384490576
http://itunes.apple.com/WebObjects/DZR.woa/wa/viewTagged?tag=Lit2Go&id=384490576
http://itunes.apple.com/WebObjects/DZR.woa/wa/viewTagged?tag=Lit2Go&id=384490576
http://itunes.apple.com/WebObjects/DZR.woa/wa/viewTagged?tag=Lit2Go&id=384490576
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Creating Your Own Content

In addition to content available in iTunes and iTunes U, you and your students can create
your own content to share on an iPad or iPod touch. With classroom Mac computers,
students can create digital projects with iLife, such as video or audio podcasts. They can
also use the applications in Apple’s iWork productivity suite to produce narrated
presentations or ePub documents.

Another valuable feature in Mac OS X is a service called “Add to iTunes as a Spoken
Track.”With this feature, students can select text in any Apple application, such as a
webpage in Safari, a PDF document in Preview, or a report in Pages, and use the Services
menu in that application to send the files to iTunes—the text becomes an audio file in a
Spoken Text playlist in the iTunes library that they can then sync to their iOS device.
Students can also use iPad and iPod touch to produce content—including
presentations, spreadsheets, and documents with the iWork apps on iPad, photos and
movies on iPad and iPod touch, musical compositions with the GarageBand app on
iPad, and other audio files on both devices. This section discusses just some of the
possibilities.

Producing Digital Content with iLife

Apple’s iLife suite is unparalleled in allowing you and your students to easily create
media-rich projects on a Mac. Producing digital media projects gives students a
compelling way to learn and express their knowledge in any curriculum area. With iPad
and iPod touch, students have an exciting tool with which they can share those
projects. The iLife suite, which is included with every new Mac, includes the following
applications:

iMovie can be used for creating digital movies and video podcasts that can then be
exported to iPad and iPod touch for viewing. (See “Creating Video Podcasts with iMovie”
later in this guide.)

iPhoto can be used for importing, organizing, editing, and sharing photos. These photos
can be used in iMovie projects and Keynote slide presentations and added to podcasts
created in GarageBand. Students can also use iPhoto to create photo books on any
topic. The books, movies, presentations, and podcasts can be synced to iPad and iPod
touch as well as photo albums in iPhoto. The photos and movies students take with iPod
touch can also be synced to their iPhoto library on the Mac.

GarageBand can be used to create and record music and podcasts, which can then be
exported to iTunes and synced to iPad and iPod touch. (See “Creating Podcasts with
GarageBand, later in this guide.)

iWeb can be used for creating webpages, blogs, and podcast feeds. Once published on
the Internet, others can subscribe to student podcasts and access other student work
and view them with Safari (and Wi-Fi) on iPad and iPod touch.

All of these applications are simple to use and work seamlessly with one another with
the included Media Browser. For example, a podcast created in GarageBand can be used
on a webpage created in iWeb. Photos in iPhoto and music files in iTunes are easily
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imported into iMovie. Movies, music, and podcasts can be sent to iTunes with just one
click and then easily synced to iPad or iPod touch.

Producing Podcasts

Creating a podcast is an excellent and easy way for you to create content for students to
use on iPad or iPod touch as well as for students to share what they've learned with a
real audience.

For example, you could create podcasts with test review information, science lab
instructions, or language exercises. Students can then view these materials at their own
pace and review them as needed. Students could create a weekly podcast recap of what
they've studied for the week. This could be distributed to parents and the general public
as a way to showcase the quality work occurring in your classroom or school. Students
could create a podcast of poetry readings or book reports, providing motivation for
writing in the classroom. They could also publish summaries of science projects or
reports of school sporting events.

You and your students can use GarageBand to produce podcasts that combine sound
and images or use iMovie to create video podcasts that can include video footage,
photos and other images, narration, music, sound effects, and more.

Podcast Examples

Before students begin creating podcasts themselves, you may want to review or share
with the class some examples of podcasts other students have created. A few of these
are listed below.

Radio WillowWeb: Willowdale Elementary School students in Omaha, Nebraska have a lot
to share about what they learn.

www.itunes.com/podcast?id=73800253

A School in the Coulee: Longfellow Middle School students in La Crosse, Wisconsin
produce this podcast on topics from literary adaptations to the continent of Africa.

www.itunes.com/podcast?id=79169064

Podcast Central: This comprehensive collection of podcasts is produced by the students,
teachers, and administration of Mabry Middle School in Marietta, Georgia.

http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewPodcast?id=73888013

Creating Podcasts with GarageBand

To create a podcast that includes just audio or audio and images, you just need
GarageBand, a computer with a built-in microphone, and your students’ creativity. To get
started, students open a new podcast file in GarageBand. They click simple controls to
start, stop, and play back recording, then add sound effects, jingles (short music snippets
designed for podcast use), and other music. GarageBand will automatically adjust the
sound quality and volume levels. Students can also create an enhanced podcast by
adding photos or other images from an iPhoto library to enrich the podcast and help to
tell the story. Students could even add hypertext links that send listeners to relevant
websites.


http://www.itunes.com/podcast?id=73800253
http://www.itunes.com/podcast?id=73800253
http://www.itunes.com/podcast?id=79169064
http://www.itunes.com/podcast?id=79169064
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewPodcast?id=73888013
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewPodcast?id=73888013
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Students can then publish the podcast to the iTunes Store, send their podcast episode
to iWeb and publish it on the Internet with a MobileMe account, or add it to a school
website.

Creating Podcasts with iMovie

To create a video podcast or another movie project, students open iMovie and create a
new movie project, selecting an Apple-designed theme for the project if desired. They
add video clips that are already saved in an Event in iMovie or that they import from a
camera, the computer’s hard disk, or another source. They drag the video clips that they
want to include to the iMovie project area and then can add sound effects, music, maps,
photos, and other images. They can record voiceover narration using the computer’s
built-in microphone and add title slides and transitions. They can also add a green-
screen effect to make it look like a person is talking in front of a different background or
add a solid color or animated background.

To view the finished movie on iPad or iPod touch, they send it to iTunes directly from
iMovie and then sync it to the iOS device.

Making Movies with iPad and iPod touch

In addition to producing movies with iLife on a computer, students can film and edit
movies on the go with the built-in HD video camera on iPad and iPod touch. For
example, students could conduct interviews of family members or of subject experts in
the community or take footage while on a class field trip. After they shoot video,
students can use the built-in editing tools to choose what parts of their movie to keep.

Students can polish the movies they take by using the iMovie app available for
download from the App Store. The iMovie app is designed to take advantage of the
capabilities of Multi-Touch. With the app, they can add a theme, music, photos, titles,
narration, and transitions to their movies as well as combine and edit clips. And on iPad,
they can also fine-tune their edits with the Precision Editor for advanced editing. They
can then share their completed movie projects in three sizes via YouTube, MobileMe,
Vimeo, or CNN iReport, by email, by syncing them to a computer, or showing them to
the class on with a TV or a projector. (For more information, see “Accessories for iPad and
iPod touch” later in this guide.)
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If students are producing iMovie projects on the Mac, they can take video and photos
on iPad or iPod touch and then import the clips and photos to their iMovie projects on
the Mac to use as part of their projects.

Making Music with GarageBand on iPad

With the GarageBand app for iPad, students can use Multi-Touch gestures to experience
the excitement of creating music. They can choose from a wide range of Touch
Instruments, such as a grand piano, an electric organ, or an acoustic guitar, plug in their
own instruments, and use the built-in Guitar amp and effects. Even students with no
musical experience can tap melodies on a piano, strum chords on a guitar, and more
using a set of specially designed Touch Instruments called Smart Instruments. Students
can then arrange and mix songs using a complete eight-track recording studio and
more than 250 loops. When a composition is done, it can be exported to an iTunes
library or sent to others via email. GarageBand on iPad is also compatible with
GarageBand on the Mac, so students can work on the same musical piece on both the
computer and iPad.

Using iPod touch and iPad for Voice Recording

You and your students can record memos, lectures, interviews, small group discussions,
and more on iPod touch (with the built-in Voice Memos app) and on iPad (with the
addition of a third-party recording app). Reading samples can be captured for
assessment purposes or for students to use for self-reflection. Students learning a
foreign language can record themselves to practice speaking and fluency. You can use
iPod touch or iPad to dictate instructions for science labs, lesson plans, and research
notes, or to record “to-do” lists as you think of them. Voice recording on your iOS device
can also be used for recording staff or parent meetings instead of transcribing them. You
can share what was recorded by posting the audio file on a website.

With both iPod touch and iPad, you can use the built-in microphone to record or attach
an external microphone or use the microphone on Apple Earphones. Recorded audio
files can be reviewed later on iPod touch with the built-in speaker or on iPad or iPod
touch by using headphones. When you connect your iPod touch to your Mac, audio
recordings made with the Voice Memos app are copied to iTunes. The files are stored in
a Voice Memos playlist in iTunes and can also be shared by email from the device.
Playlists can be created in iTunes to store each student’s recordings in a digital portfolio.
Recorded audio files can be reviewed in iTunes, edited in GarageBand on a Mac, and
used in other projects, such as for narration in a podcast or a documentary movie
project.

Creating and Sharing Presentations

Another great feature of iPad and iPod touch is the ease with which you can share and
view presentations that you and your students produce. Presentations can even be
created on iPad using the Keynote app, designed for Multi-Touch and available from the
App Store.

Students could use a presentation to share their findings from a lab experiment, to
produce flash cards for review, or to demonstrate what they have learned about a
period in history. You can use presentations to introduce a unit of study or to share
classroom events with students’ families.
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Using Keynote on a Mac or the Keynote app on iPad, students can choose from a
collection of Apple-designed themes and then create slides with text, charts, tables,
photos, their own artwork, and movies. They can add animation effects and transitions
to enhance their presentations. Presentations created with the Keynote app on iPad can
be copied to a MobileMe iDisk or a standard WebDAV server, sent via email, or
transferred to a computer via iTunes. With Keynote on the Mac, they can also add
voiceover narration to their presentations, send presentations to iTunes from Keynote,
and then share them by syncing them to iPad or iPod touch. To share a PowerPoint
presentation, you export it in the QuickTime movie format and then import it into
iTunes and sync it to iPad or iPod touch.

Connecting the iPad or iPod touch to a presentation device—such as a projector or
television monitor—makes presentations incredibly portable. For more information, see
“Accessories for iPad and iPod touch” later in this guide.

Creating and Sharing ePub Documents

With ePub documents, you and your students have a powerful and easy way to publish
content on an iOS device. The first step is to create a digital document in Pages on the
Mac that can combine text with movies, audio, photos, tables, and other elements. Next,
you export the file in the ePub format. Now it can be added to iTunes and then copied
to an iOS device. The ePub document will appear on the bookshelf in iBooks to be
viewed on iPad and iPod touch just like any other book. Because the iBooks app uses
the ePub format, the most popular open book format, any files using that format can be
added to the bookshelf. Students can then read those publications using the features
available with books downloaded from the iBookstore—they can add bookmarks, look
up words in the dictionary, search for and copy text, highlight text, and so on.

The possibilities are numerous. Students might author a storybook that includes movies
of themselves acting out scenes to be shared with younger students in another class.
Students might share a journal about a piece of literature, a travel brochure for a trip to
Mars, or a lab report with images and graphs of their findings. You can create
background information for a unit, test review materials, or lab instructions.

To create files for use in iBooks, in Pages, create your document and then choose
Share > Export and click ePub. Drag the exported ePub file into your iTunes Library and
then sync your iPad or iPod touch with the computer.

Similarly, you can export your Pages documents as PDF files, add them to your iTunes
library, and sync them to iPad or iPod touch for reading on the device.
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Using iWork on iPad

You and your students can produce a wide array of spreadsheets, presentations, and
documents using the iWork apps on iPad. The Numbers, Keynote, and Pages apps have
been designed to take advantage of the features of iPad and Multi-Touch and can be
downloaded as individual apps from the App Store.

As discussed in “Creating and Sharing Presentations,” you and your students can use the
Keynote app to produce great-looking presentations on any topic. When you create a
new presentation, you have a choice of a range of Apple-designed themes, such as
Chalkboard and Photo Portfolio; each theme offers a variety of slide layouts with
coordinated backgrounds and fonts.

Numbers provides a flexible canvas to create spreadsheets that also include tables,
charts, text, images, and even videos.

And with Pages, you and your students can write all sorts of documents, such as reports,
essays, and newsletters, by tapping the screen and typing with the large iPad keyboard
that can suggest words, correct spelling, and insert punctuation.

The iWork apps include many options for sharing files. You can send and receive files via
email, copy files to and from a MobileMe iDisk or any standard WebDAV server, and
transfer files between your iPad and computer through iTunes. You can share iWork app
files back and forth with iWork documents on a computer for maximum flexibility. You
can open and edit Pages and Word documents in Pages on iPad, PowerPoint and
Keynote presentations in Keynote on iPad, and Excel and Numbers spreadsheets in
Numbers on iPad. You are also able to open iPad iWork documents in iWork or Microsoft
Office on a Mac for further polishing.
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Using the Apps Included with
iPad and iPod touch

The apps that come with iPad and iPod touch offer a set of valuable resources that
support teaching and learning in the classroom. Students can listen to downloaded
audio and view video content, browse the Internet, take notes, use a calculator, check
email, create and sync calendars, and more. This chapter provides an overview of many
of these apps.

Videos

iPad and iPod touch allow you to view full motion video downloaded from iTunes,
including free education movies in iTunes U, feature films, TV shows, video podcasts, and
instructional media. Also, both devices integrate seamlessly with iMovie on the Mac and
movies created with the iMovie app on iPod touch, so student productions can be
viewed on the go.

To play a movie, tap Videos, then tap the video you want to view. (On iPod touch, videos
automatically play in widescreen to take advantage of the full iPod touch display. On
iPad, you can view movies in either portrait or landscape mode.) To display the video
controls, tap the screen once; tap it again to hide the controls.

Camera

With Camera, you and your students can use the cameras built in to iPad iPod touch to
take photos and capture video and then easily view the results.

Tap Camera, then drag the slider at the bottom right to choose to take photos or video.
To take a photo, tap the Camera button at the bottom center of the screen. To capture
video, tap the Record button at the bottom center of the screen and tap it again to stop
filming. You can then use the iMovie app to edit your video (see “Making Movies with
iPad and iPod touch” earlier in this guide). Photos taken or video captured with Camera
can be sent to others via email or sent to MobileMe and displayed on the web; photos
taken can be used as wallpaper (background) on the device. The photos and video can
also be synced to a Mac and used in projects students create on their computer, such as
podcasts, movies, presentations, documents, or photo books.

Photos

With Photos on iPad and iPod touch, you can view photos and images transferred from
your computer, saved on the device, or taken with the camera on iPod touch. Photos can
be viewed in portrait or landscape mode and as a slideshow. Photos can also be used for
wallpaper (the image displayed in the background of iPad and iPod touch).

Tap Photos to see the images available on the device. Tap to display photo controls.
Double-tap an image to zoom in.
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Safari

With Safari, and a Wi-Fi connection for iPod touch or iPad, you and your students can
browse websites and search for information on the Internet, including Google searches.
For example, the Safari app can be used to readily access the wealth of resources
available from the Discovery Education website (www.discoveryeducation.com). With
Safari on the iOS device, students can do research both in and outside of the classroom
and can have up to eight webpages open at a time. Files in PDF format can be
downloaded and viewed as well.

You can also add bookmarks and sync them to iPad or iPod touch from a computer,
particularly helpful if you want to provide students with a group of websites to use for
research. You can add bookmarks directly from the iPad and iPod touch as well. You can
even add a frequently-used website to the device’s Home screen for easy access.

Websites can be viewed in either portrait or landscape orientation—you just rotate the
device to change the orientation. It's easy to scroll around webpages or to zoom in and
out on a page. Just double-tap or pinch to zoom in and out.

Notes

With Notes, you can easily add, read, and revise notes that appear onscreen on a yellow
notepad. If the iPad or iPod touch is set up for email, you can also email notes that
you've created. Notes can be synced with the Mail application on a Mac. Notes can be
used for to-do lists, for meeting summaries of students’ collaborative projects, at staff
meetings and field trips, and more. And because you can copy and paste text with the
device, you can copy text from a webpage or an email and add it to a note.

To add a note, tap Notes, then tap the Add button (+). When you are finished typing a
note with the keyboard on iPad, tap the Keyboard icon. When you're done typing a note
on iPod touch, tap Done. With both devices, tap the envelope at the bottom of the
screen to email your note. Tap Notes at the upper left of the screen to view all of your
notes.

Mail

The Mail app can be used to receive and send emails when an iPad or iPod touch has
joined a Wi-Fi network that is connected to the Internet. The email account settings
need to be added to the device’s Settings or added in iTunes when the device is
connected to your computer. You can send and receive photos and movies as part of an
email message and can view attached PDFs and other files.

Calendar

To keep track of important dates or school schedules, you and your students can use the
Calendar feature of iPad and iPod touch. You can enter and edit calendar events directly
on the device. Students can use Calendar as an organization tool as well, for example, by
setting a time to work on a project with an alert to remind them to get started. You can
also create calendars with iCal (included on every new Mac) or Outlook, such as a class
calendar with due dates for projects, school holidays, field trips, and other school
activities, and then sync the calendar to iPad or iPod touch to share with the class.
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iBooks

iPad and iPod touch are versatile book readers. The iBooks app is available as a free
download for iPad and iPod touch from the App Store. With this app, you and students
can customize the reading experience and also buy books or download free books.

To get started, tap iBooks. A bookshelf appears with books that you have added to your
collection. Tap Store to locate and add books to your device. When viewing a book, you
can highlight text, add notes, look up a word in a dictionary, search for terms, and more.

See “Reading Books with iPad and iPod touch” earlier in this guide for more information.

FaceTime

You and your students can use FaceTime to participate in video calls that are made
using a Wi-Fi connection with others who are using iPad 2, iPod touch (4th generation),
or iPhone 4.

To get started, tap the FaceTime app and tap the name of the person to call from your
Favorites list. An invitation appears on that person’s device screen asking if he or she
wants to join you. When the person accepts, the video call begins.

Contacts

You and your students can have contact information synced to iPad or iPod touch from
MobileMe, Address Book, Google Address Book, Windows Microsoft Outlook, or
Microsoft Exchange. You can also add contact information to the devices directly.

To view all the people on your contact list, tap the Contacts icon. To add a contact, tap
the Add button (+). Enter the contact information for that person and then tap Done.

Settings

Device settings can all be adjusted in the Settings panes. You can set your wallpaper
(the image displayed in the background of iPad and iPod touch), screen brightness, and
settings for network, accessibility, mail, web, music, video, photos, and more. In Settings,
you can also set auto-lock and a passcode for security and restrict access to explicit
iTunes content and certain apps.

To open settings, tap Settings, and then tap a category on the left.

Maps

With the Maps app and a Wi-Fi connection, you can see street maps, satellite photos,
and street views of locations in many of the world’s countries and regions—a wealth of
information that students can use in their projects. For example, students can view the
actual terrain of the Oregon Trail or the Pyramids in Egypt. You can also get detailed

traffic information as well as driving, public transit, and walking directions to specific
locations.

iPod (on iPad)

By tapping iPod on your iPad, you can access content that has been downloaded from
iTunes and iTunes U, including enhanced podcasts, audiobooks, student voice
recordings, famous speeches, songs, and more. To browse your audio collection, tap
iPod, then tap Music, Podcasts, Audiobooks, or iTunes U. Tap a title to play it.
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Music (on iPod touch)

By tapping Music on your iPod touch, you can access content that has been
downloaded from iTunes and iTunes U, including enhanced podcasts, audiobooks,
student voice recordings, famous speeches, songs, and more. To browse your audio
collection, tap Music, then tap Playlists, Artists, Songs, or Albums. Tap More to browse
Audiobooks, Compilations, Composers, Genres, or Podcasts. Tap a title to play it.

Photo Booth (on iPad)

With Photo Booth, you and your students can take photos of each other and then add
fun effects to them. Tap Photo Booth to open the app. The front-facing camera is used to
take photos with Photo Booth, so you just need to hold up the iPad and tap the camera
icon at the bottom of the screen to take a picture. You can use the photo as is or choose
an effect. The photos are saved to the Photos library on iPad and can be emailed to
others or added to projects created with iWork for iPad or iMovie for iPad.

Calculator (on iPod touch)

With Calculator, you tap the onscreen buttons to enter figures and perform calculations.
Calculator makes it easy for students to keep track of their calculations—when you tap
the add, subtract, multiply, or divide button, a white ring appears around that button to
indicate what operation is selected. When you rotate the iPod touch, the calculator
changes to a fully functional scientific calculator with dozens of functions. (Calculator is
included with iPod touch; for iPad, you can download many different calculator apps to
perform these functions.)

Clock (on iPod touch)

You and students can use the Clock app to see what time it is in other parts of the
world, to set repeating or one-time alarms, and use a stopwatch and timer.

To use the Clock app, tap the Clock icon, then tap World Clock, Alarm, Stopwatch, or
Timer to use that feature.

A variety of Clock apps are available for download from the App Store for iPad.

Voice Memos (on iPod touch)

As discussed in “Using iPod touch and iPad for Voice Recording,” iPod touch includes the
Voice Memos app with which you can record all sorts of audio files. You can sync the
files to your iTunes library or share them via email. (You can download a voice recording
app for iPad from the App Store.)

To record, tap Voice Memos from the Home screen, then tap the red Record button to
start recording. Tap this button again to stop recording. To hear your recording, put on
earbuds and tap the “Go to voice memos” button (with the horizontal lines).
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Adding Content to an iOS Device
Using iTunes

The first time you connect iPad or iPod touch to a computer, Setup Assistant appears
and guides you to name the device and select settings for syncing. You can set iTunes to
sync music, books, podcasts, iTunes U content, other audio files, movies and TV shows,
apps downloaded from the App Store, photos, contacts, notes, calendars, email account
settings, and webpage bookmarks.

You can adjust sync settings at any time the device is connected to a computer. With the
automatic syncing option, you can choose to sync all of your content whenever the
device is connected to the computer or have iTunes sync just some of it, such as
particular playlists, apps, or photo albums. With the manual syncing option, when you
connect the device to a computer, you select the specific items you want to sync when
you connect the device to the computer.
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How you choose to set up syncing will vary depending on how you will manage the iOS
devices in the classroom. (See “Managing iPad and iPod touch and iTunes for Student
Use” later in this guide.) For example, if you will sync a classroom set of iPad or iPod
touch devices using an Apple iPad Learning Lab or Apple iPod Learning Lab, you may
want to sync them automatically with selected content. Students who are assigned their
own device may want to manually select items to sync from a class computer. This
section provides an overview of the syncing options in the settings panes in iTunes.

To set up iPad or iPod touch for syncing:

. Connect the iPad or iPod touch to your computer and open iTunes (if it doesn’t open

automatically).

. In'iTunes, click the iPad or iPod touch icon under Devices in the left sidebar.
. Click the Summary tab if the Summary pane is not already open.

. Select syncing options in the Summary pane:

Select the option to have iTunes open automatically when the device is connected if
you want iTunes to open and sync the device automatically whenever you connect it to
the computer. Deselect this option if you want to sync only by clicking the Sync button
in iTunes or if you want to manually manage content.

Select “Sync only checked songs and videos” if you want to sync only items that are
selected in the computer’s iTunes library.

Select “Manually manage music and videos” to turn off automatic syncing in the Music
and Video settings panes. If you select this option, you add items to the device by
dragging them from the iTunes library. For more information about the Summary pane
options, see the user guides for iPad and iPod touch, available at www.apple.com/

support.

. To sync the library’s music, movies, TV shows, and podcasts, click the Music, Movies, TV

Shows, Podcasts, and iTunes U tabs and select to sync all the titles in that category or
just selected ones.

. To sync the library’s Photos, click the Photos tab and select the options you want.

. To select the sync setting for MobileMe, contacts, calendars, email accounts, notes, and

web browser bookmarks, click the Info tab and make the selections you want.

. To specify App Store apps to install on iPad or iPod touch from your iTunes library, click

the Apps tab.

. When you're finished, click Apply.

iTunes starts loading your device with the selected content. This can take several
minutes if the iTunes library is large.

When the device no longer displays the “Sync in progress” message, you can safely
disconnect it.

When you use your iPad or iPod touch to record audio or download items from the Wi-Fi
iTunes Store or the App Store, those items are synced from the device back to your
iTunes library.

See “Resources” later in this guide for links to additional sources of information.


http://www.apple.com/support
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http://www.apple.com/support
http://www.apple.com/support

Getting Started with Apple iOS Devices: 28
A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Accessibility and iOS Devices

In addition to being designed for ease of use, simplicity, and the user experience, Apple’s
iOS devices have also been designed for accessibility and as an aid to diverse learning.
iPad, iPod touch, and iTunes offer many features and apps that can help accommodate a
range of students with special needs.

Vision
iPad and iPod touch have valuable built-in accessibility features for students who are
blind and low vision, which are also available with Mac OS X on Mac computers:

White on Black: The screen be displayed as photonegative, with white text on a black
background.

VoiceOver: This gesture-based screen reading technology uses speech to describe what
is happening onscreen. It can also be used to have the contents of a page, such as a
book in iBooks or a webpage in Safari, read aloud. When VoiceOver is on, it changes the
gestures used to control the device so students who are blind and low vision can
navigate and use the device much like their sighted counterparts. VoiceOver supports
over 30 different languages and can be used with over 30 different models of Bluetooth
braille displays.

Zoom: Images on the screen can be magnified by up to 500% so elements are easier to
see and read.

Zoom, White on Black, and VoiceOver can be configured for use on your iOS device in
iTunes when an iPad or iPod touch is connected to your computer. To manage these
settings in iTunes, click Configure Universal Access in the iTunes Summary pane. They
can also be set on the device itself by going to Settings > General > Accessibility.

If Zoom, VoiceOver, or White on Black is only used sometimes, you can turn on the Triple-
click Home option in Accessibility settings. With this option, you press the Home button
three times to turn that feature on and off.

Voice Control is another feature that students who are blind and low vision can take
advantage of on iPod touch (see “Physical and Motor Skills,” below).

Additionally, the Sleep/Wake button and Volume buttons on iPad and iPod touch are
located and designed in a way that vision-impaired students can readily navigate them.
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Hearing

iPad and iPod touch include accessibility features for those who are deaf or hard of
hearing. Closed caption content can be viewed in iTunes and on iPad and iPod touch.
Additionally, content with subtitles can be viewed in iTunes and iPad.

To set up the device to display closed captions, on the iPad or iPod touch, go to
Settings > Video, and select On for Closed Captioning. Alternatively, you can turn on
closed captioning from the iTunes Summary pane when the device is connected to the
computer. Click Configure Universal Access, then select “Show closed captions when
available.”

It's easy to find closed caption movies and iTunes U content in the iTunes Store by using
a Power Search. The CC logo appears in descriptions of captioned content.

Mono audio is a helpful feature for some students, especially those who have limited or

no hearing in one ear. With it, you can route both right- and left-channel audio into both
earbuds so the audio is heard in both. In Settings, go to General >Accessibility and then

turn the switch for Mono Audio on or off. Mono audio can also be set up in the iTunes
Summary pane by clicking Configure Universal Access.

Accessories from third parties are available for those with hearing impairments such as
hearing aid-compatible induction ear loops and wireless remote headsets. (See
“Accessories for iPad and iPod touch” later in this guide.)

Physical and Motor Skills

The touchscreen of iPod touch and iPad is very easy to operate as it requires very simple
contact. Additionally, a stylus can be purchased separately to use to touch the screen.
The Sleep/Wake and Volume buttons on each device are also designed for ease of use.

With Voice Control on iPod touch, students can use their voice to play music by the
name of the artist, album, or playlist, and then pause, change tracks, and shuffle music.
To use Voice Control, on iPod touch, press and hold the Home button and then speak
the item you want when prompted by an audio signal.

When using iTunes, students can also take advantage of the many accessibility options
included with Mac OS X for using the keyboard and mouse, which are set in System
Preferences.

Apps for All Learning Styles

A wealth of apps are available to aid students with diverse needs. Just a few are
mentioned here, each of which is available for both iPad and iPod touch:

iBooks from Apple Inc.

With the free download of the iBooks app, students can download and read books and
customize the pages to best meet their needs. They can enlarge the font size, use zoom,
and look up words in a dictionary from the page. And because iBooks takes advantage
of the inherent accessibility of the iOS, it works seamlessly with VoiceOver.



Getting Started with Apple iOS Devices: 30
A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Dragon Dictation from Nuance Communications

The Dragon Dictation app transcribes words you record into text files. This is a great way
for students who have a hard time with onscreen keyboards or keyboards in general to
express themselves in written format. Once the text has been transcribed, it can be
edited and sent via email or added to a blog or wiki site.

Proloquo2Go from AssistiveWare

The Proloquo2Go app is an augmentative and alternative communication (AAC) system
for students who have difficulty communicating verbally. Students tap phrases or words
that have associated illustrations to add to a message window. Then you tap the
message window to hear what the student wants to say. Messages can be saved to use
again later. Students can customize the app with their own entries and use their own
photos or other images.

Sign 4 Me from Vcom3D, Inc.

The Sign 4 Me app is primarily used for learning sign language and as a sign-language
translator. A three-dimensional character signs the words that you enter, either once or
in a loop. The library includes more than 11,000 words. You can move the character
around the screen, zoom in and out, and change angles to see the signing from different
views. Words or phrases you've typed are saved in history so it’s easy to repeat them.

SoundAMP R from Ginger Labs

Sound AMP R is an app for those who need to amplify the sound coming in externally
on the iOS device. It amplifies the sound and the Repeat button lets you hear what was
just said again.

iSeeClearly from The Newport Avenue Group

This app helps you to read small print on iPod touch and iPhone. Using the built-in
camera of the device, you can zoom in up to ten times and freeze images to read them.

Pocket SLP Articulation

Developed by speech and language pathologists, the app provides a multisensory
approach to articulation drills. It includes more than 2100 built-in flash cards tagged at
both a word and sentence level and includes auditory feedback.

To view a more comprehensive list of apps, visit the Special Education collection on the
iTunes Store for iPod and iPhone and for iPad.


http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewMultiRoom?fcId=399470369
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewMultiRoom?fcId=399470369
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewMultiRoom?fcId=399470755
http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewMultiRoom?fcId=399470755
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Managing iOS Devices and iTunes
for Student Use

This section provides suggestions for how to best to manage iPad, iPod touch, and
iTunes in your classroom. Because iPad and iPod touch are designed to be paired with
one computer or user account, the way you use these devices in the classroom will
determine how you decide to set up user accounts on the computers.

Getting Students Up to Speed

Most students will not need instruction on how to use iPad or iPod touch, but you might
want to review specific items such as how to access different types of content and how
to start and stop an audiobook or a movie. You might consider using a document
camera to project items on an iPad or iPod touch to share with your students (see
“Accessories for iPad and iPod touch” later in this guide). You also may want to
demonstrate to the class how to use iTunes and the other applications they will be
using, such as GarageBand or iMovie for creating a podcast.

Managing iPad and iPod touch in the Classroom

There are different scenarios for managing the use of iOS devices in the classroom,
which vary depending on whether each student is assigned his or her own device and
on how you manage syncing of content.

Each Student Has His or Her Own iOS Device and iTunes Library

With this scenario, each student is assigned his or her own iPad or iPod touch and also
maintains his or her own iTunes library, either on a computer assigned to that student or
on a shared computer (see “Setting Up Student Groups and Accounts” later in this
guide). Students then download, manage, and sync their own content to the device.

Each Student Has His or Her Own iOS Device and Syncs to a Shared
iTunes Library

With this scenario, each student is assigned his or her own iPad or iPod touch and syncs
from a shared iTunes library on a computer or over the network. Students manage their
own syncing and may use customized settings on their device to sync only certain
content from the iTunes library, such as specific podcasts, apps, or playlists. (See “Adding
Content to an iOS Device Using iTunes” earlier in this guide.)
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Each iOS Device Is Synced with the Same Content

Another way to manage iPad and iPod touch in the classroom is to have them all synced
with the same content and apps from an iTunes Library. Syncing to multiple devices can
be done easily via an Apple iPad Learning Lab or the Apple iPod Learning Lab (sold
separately). These mobile labs make it easy to manage iOS devices in the classroom and
to share them among multiple classrooms. With this scenario, students may check out
an iPad or iPod touch for a specified amount of time, such as a class period, or may have
an individual device assigned to them. (For more information, see “Mobile iOS Learning
Solutions” later in this guide.)

Setting Up Student Groups and Accounts

Mac OS X is the current version of the Apple operating system. Mac OS X is a multiuser
system designed to create distinct spaces for each user’s work. With Mac OS X, each
computer has at least one “administrator” account used for installing software, changing
settings, and setting up additional user accounts. Each user account has its own iTunes
library as well as a Documents folder and other folders set up to store different types of
files.

Once a user account is set up on a computer, the person using that account logs in as
that user and can only see that user’s files. Accounts are set up from the Accounts pane
of System Preferences. (Open System Preferences, then click Accounts. An administrator
clicks the Add button (+) to add a new user account.) To learn more, choose Help >
System Preferences Help when System Preferences is open or go to the Mac OS X
Support site at www.apple.com/support. The following sections describe different ways
you might want to set up the student user accounts on a Mac for use with iOS devices.



http://www.apple.com/support
http://www.apple.com/support
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Providing Customized Content for Individual Students

If you want to provide specific items, such as videos, music, and podcasts, for individual
students, you can do this by creating separate playlists in iTunes. As described in the
previous section, you could use the Accounts pane of System Preferences to set up one
student group user account that would include your main iTunes library. You could then
provide individualized content for each student by creating a playlist in iTunes that
contains specific items to be used by that student. If you set the devices to sync
manually, you could drag each student’s playlist to the iPad or iPod touch he or she will
use. Playlists can also be used for special projects or for organizing content by subject.

To create a new playlist in iTunes:

. Choose File > New Playlist, or click the Add button (+) in the bottom-left corner of the
iTunes window.

. Type a name for the playlist.

. Click Music (or another item in the Library section in the left sidebar) and then drag an
item to the playlist. To select multiple items, hold down the Command or Shift key while
you click. Note that apps cannot be added to playlists.

Another way to provide customized content for each student is to create one user
account for each student using the computer. Although such accounts take longer to
create initially, this is a good way to provide privacy for student work saved on the
computer. You may also want individual accounts when students need special settings
on the computer to accommodate learning or other disabilities. iTunes and iPhoto
libraries would be unique to each student account, and the devices would be synced for
individual student content using this type of setup.

Providing Separate Content for Each Class

If you have multiple classes using the same computer, you could set up one user
account for each class. If students save their work to individual computers rather than to
a server, separate class accounts would make it faster for students to locate their work
because the account would only include work saved by students in that particular class.

Each class account would have its own iTunes and iPhoto libraries, apps, and other
synced items, which would allow the content to be different for each class, such as one
account for first year French and another for AP French. This would allow you to sync the
iPad and iPod touch devices with the content needed for each class.

Another way to provide separate content for each class would be to create a playlist for
each class in a shared iTunes library.
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Providing the Same Content for All Students

If you want all of your classroom iPad and iPod touch devices to contain the same
content, one way to do this is to set up a computer with two user accounts—an
administrator account for you, and one student account that all students share. With this
setup, a student using the computer would log in with the student group username and
password. You would log in to that computer using the administrator account.

All of the students would share a common iPhoto and iTunes library, apps, bookmarks,
email setup (if any), and so on. When the iOS device is synced with the computer, the
content from the shared student account’s iTunes and iPhoto libraries and other items
to be synced would be loaded onto the device. Many teachers find setting up a single
student user account for use with classroom sets of iPad or iPod touch to be the easiest
way to manage and distribute content. If the classroom has an Apple iPod Learning Lab,
Apple iPad Learning Lab, or PowerSync Case (see “Mobile iOS Learning Solutions”), you
can sync multiple devices to one MacBook.

Volume Purchase of iOS Apps

Apple has created the App Store Volume Purchase Program to make it easy for
educational institutions to purchase iOS apps in volume and distribute those apps to
their users. With the App Store Volume Purchase Program, schools can purchase apps in
volume using a purchase order, PCard, or credit card. If the institution is tax exempt, the
school is not charged sales tax when purchasing apps. The App Store Volume Purchase
Program has provisions to allow schools to synchronize purchased apps to multiple
devices, subject to terms and conditions. The program also allows app developers to
offer special pricing for purchases of 20 apps or more. For more information, see
www.apple.com/itunes/education.

Managing Settings on iOS Devices

There are three ways to configure and manage settings on iOS devices: directly on the
device, by using iPhone Configuration Utility, or by using a Mobile Device Management
(MDM) solution.

Direct Device Management

It is possible to manually select setup options directly on the iPad or iPod touch in the
Restrictions pane in the General section of the Settings app. This is the simplest setup
method and requires manually entering all configuration information into each device.
This may be best when there are small numbers of devices or when teachers or
volunteers are doing setup on their own.To learn more about device restrictions, go
to: http://support.apple.com/kb/HT4213.



http://www.apple.com/itunes/education/
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Using iPhone Configuration Utility

Entering settings on multiple iPad and iPod touch devices can be simplified with the use
of iPhone Configuration Utility, an application available for free download from Apple for
both Mac OS X and Windows platforms. This application can be used to create
configuration profiles for iPad and iPod touch specific to your school environment.
Configuration profiles are XML files that, when installed on a device, provide information
that the device can use to connect to and communicate with your school systems. The
profiles can include Internet wireless settings, email settings, restrictions to control the
installation of third-party apps and explicit content on the iTunes Wi-Fi Music Store, and
more. Instead of entering settings on each device, those settings are installed by
connecting to a webpage or by opening an email on the device.

To download iPhone Configuration Utility, go to:
iPhone Configuration Utility for Mac OS X
http://support.apple.com/kb/DL851

iPhone Configuration Utility for Windows
http://support.apple.com/kb/DL926

For more information about using iPhone Configuration Utility, see the Enterprise
Deployment Guide, available at: http://manuals.info.apple.com/en US/
Enterprise_Deployment Guide.pdf.

Mobile Device Management

Mobile Device Management capabilities are built into iOS 4 and give IT staff the ability
to securely enroll iOS devices in a school’s network. Mobile Device Management can
also be used to wirelessly configure and update settings of iOS devices, monitor their
compliance with a school’s policies, and even remotely erase or lock managed devices.

IT staff can take advantage of these capabilities by using Mobile Device

Management software from a solution provider that has built support for the Mobile
Device Management capabilities of iOS 4 into their current offerings. For a list of some of
these vendors, see www.apple.com/ipad/business/integration/mdm.



http://support.apple.com/kb/DL851
http://support.apple.com/kb/DL851
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Keeping Track of Student iOS Devices

One of the powerful aspects of iPad and iPod touch is that they are mobile learning
tools. Like textbooks, notebook computers, and other learning tools that may go to and
from school with students, you probably will want to asset tag the devices using the
same type of asset tags or barcodes you do for other items. If the library manages them,
you can use the same checkout system used for library materials.

If you are checking out iPad or iPod touch devices from your classroom, you might want
to use a sign-in/sign-out sheet to help keep track of them. Along with asset tags, you
might want to consider numbering each iPad or iPod touch to help you keep track of
which device is being used by which student. When you first set up each iOS device, you
are prompted to name it. You can use these same names when you set up your system
for checking out the student devices.

Another management idea is to purchase inexpensive small plastic containers and put
together an iPad or iPod touch “kit” containing a device, headphones, and a USB cable
for checkout. You can take a photograph of what should be included in the kit and tape
that photo to the plastic container.

Sharing iOS Devices

Along with checking out iPad or iPod touch devices to students to take to and from
school, there are other ways they can be shared. If you do not have a class set of
devices, you can assign one iPad or iPod touch to a group of students, using a project-
based learning approach. You can also use an audio splitter, like the Griffin SmartShare,
to allow two students to share one device.

Even one iPad or iPod touch can be effectively used for recording audio with a group of
students—simply pass the device from student to student, having them record a
reading passage for assessment or narration for a story. It's a good idea to have each
student say his or her name at the beginning of each recording for easy identification
later. (For more information, see “Using iPod touch and iPad for Voice Recording”and
“Accessories for iPad and iPod touch”in this guide.)

Mobile iOS Learning Solutions

Apple offers convenient ways to manage multiple devices in the classroom. One of these
is the Apple iPad Learning Lab, a portable lab that comes with a classroom set of 10 iPad
devices and a fully assembled sturdy and secure Bretford PowerSync Cart. The cart can
store, charge, and sync up to 30 iPad devices and has extra storage space for a MacBook
computer. The cart rolls easily around campus, so multiple classes can benefit, and can
be locked to secure the devices when they’re not in use.

You can manage your classroom iPod devices with the Apple iPod Learning Lab, which
comes with a classroom set of 20 iPod devices and a fully assembled Bretford PowerSync
Cart. With the cart, you can charge, store, and transport up to 40 iPod devices at one
time and sync 20 at a time to the same computer. The cart is compatible with all iPod
models with dock connectors and ships completely assembled. The cart also has flexible
storage space for up to four MacBook computers and a variety of iPod accessories such
as earphones.

You can purchase a pre-configured Apple iPad Learning Lab or Apple iPod Learning Lab
or build your own lab to meet your school’s specific needs.
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For more iPod portability, the Bretford PowerSync Case organizes, charges, and syncs up
to 20 iPod devices and keeps them securely stored in a durable hardshell case. If you
already have iPod devices, the case can be purchased separately.

For more information on these mobile learning solutions, visit: www.apple.com/
education/labs.

Restricting Access with Parental Controls

iTunes has preference settings that you can use for extra security, such as to restrict
access to YouTube, the iTunes Store, or to radio channels or explicit content from the
iTunes Store. You can choose to disable student access to the iTunes Store but allow
them access to iTunes U.To select these options, in iTunes, choose iTunes > Preferences,
then click the Parental button. Select the options you want, then click OK. These options
can also be set as a profile with iPhone Configuration Utility to make it easier to set up
multiple devices. See “Using iPhone Configuration Utility” earlier in this document.
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Enhancing Classroom Learning
with iOS Devices and iTunes

There is no shortage of ways you can use iPad, iPod touch, and iTunes to support
teaching and learning. This chapter provides just a few ideas for their use in the
classroom.

Increasing Language Skills

iPad and iPod touch can assist students of all grade levels as they gain vocabulary,
grammar, spelling, and related language skills. Language learners can benefit from the
devices' built-in features, such as spelling correction, as well as apps from the App Store
and iTunes U and other iTunes Store resources. For example, students can have fun while
learning spelling with customized quizzes created with the SpellBoard app while high
school students can gain vocabulary and grammar expertise to get ready for college
entrance exams with apps such as Pearson GrammarPrep and Vocabulary Central or the
Princeton Review SAT Vocabulary Challenge.

iTunes U offers many valuable resources, such as the Grammar Grater audio podcasts
from Minnesota Public Radio and the Tennessee Department of Education Language
Arts series for different grade levels. With downloads from the iTunes Store, students can
hear songs that amuse as well as teach spelling and grammar, such as from the Clifford
The Big Red Dog Top 15 ABC & Spelling Songs album.

For vocabulary practice, students can create customized flash cards using one of the
apps available for that purpose from the App Store or produce them on the computer
and then review them as needed on iPad or iPod touch.

Improving the Written Word

iPad and iPod touch can be used to support all steps of the writing process. Students
can start their writing projects with an engaging visual mindmapping app like Popplet
(for iPad) or MindNode (for iPad and iPod touch) to diagram and plan their documents
and then export their outlines to the computer. They can create written assignments on
iPad with the Pages app, which will check spelling as they type and allows them to look
up word definitions directly from the page. Creating ePub documents that then appear
on an iBooks shelf adds excitement to the writing process for students.

With the StoryKit app, students can create electronic storybooks that include text and
illustrations drawn on the screen and sounds recorded with the device.

High school students have 24/7 access to essay creation assistance with apps such as
the Achievers Writing Center Essay Czar app. And you can enhance your writing
curriculum with resources from iTunes U such as Writing Process from the Maine
Department of Education, a collection of video resources for educators about the
writing process.
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Building Reading Fluency

iPad and iPod touch offer many opportunities for students to read, hear, and record text
to develop their reading fluency skills. One way is with interactive book apps like Milly,
Molly and the Bike Ride in which students can read and hear the text of an engaging
story (in multiple languages) and even record themselves reading it and play back what
they recorded.

Many students find it valuable to listen to audiobooks, often following the written text
onscreen or in the printed book at the same time. Even for fluent readers, listening to
audiobooks can provide audio reinforcement of their reading skills. (See “Reading Books
on iPad and iPod touch” for more information.) In addition to downloading audiobooks,
older students can produce books for use by younger students.

Students can record themselves as they practice reading fluency and save the
recordings in a playlist in iTunes as a digital portfolio to show progress throughout the
school year. (See “Using iPod touch and iPad for Voice Recording” earlier in this
document.)

Reading fluency can also be enhanced if students can read the text of an audio file
while they listen to it. For example, if you or your students record a reading sample (or if
the Send to iTunes as a Spoken Text service is used to convert written text to an audio
file in iTunes, described in “Creating Your Own Content” earlier in this guide), text can be
added in iTunes. If this is done, when students listen to the audio on their device, they
can tap the screen and view the text. To do this, in iTunes, select the audio file and then
choose File > Get Info. Click Lyrics in the toolbar and either choose Edit > Paste to paste
text you copied from a website or document or type the text directly. Next, click
Options in the information window toolbar, and then choose Music from the Media Kind
pop-up menu. After the audio file is synced to the iPad or iPod touch, the student just
taps the screen as the audio is playing to see the text.

Many resources are specifically designed to aid English language learners. For example,
the Pocket English (ESL) app features dialogues of several minutes along with lesson
reviews, vocabulary lists, and other features to reinforce learning. Each of the three
Pencil Bot ESL apps combines videos and interactive mini-games for different levels of
English language learners. Other apps, such as Starfall ABCs, can be used with young
learners to practice language and phonics skills. The iTunes Store offers other resources
for ELL students and their teachers, such as podcasts designed for ESL students and the
University of North Carolina’s School of Education English as a Second Language (ESL)
Workshop video, audio, and transcript files available in iTunes U.

Learning World Languages

Students who are studying a world language can download apps to practice the
language, such as the Byki or uTalk apps for a variety of languages, or interactive books
in another language such as Little Red Cap, a French version of Little Red Riding Hood.
They can quickly look up words and hear them pronounced in different languages with
a variety of translator apps. Using resources available on iTunes U and the iTunes Store,
they can listen to audiobooks and other recordings, such as the news in Spanish,
practice dialogues with iTunes U language courses, and watch videos to learn words and
phrases. Students will enjoy using Word Lens—it allows you to instantly translate
printed words from one language to another using the video camera. They can also
record themselves using video or voice recording to practice the language and improve
their fluency.
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Increasing Reading Comprehension

Reading books with iBooks provides students with many ways to increase their reading
skills and deepen their understanding of what they read. Younger students have
immediate access to a dictionary to look up words as they occur in the book and can
increase the font size. Older students can use the search and bookmark tools as they
analyze and write about literature. For example, they can use these tools to search for
quotes by a specific character or for a recurring symbol or when they want to be able to
return to a passage to quote it.

Another way to help students strengthen their reading skills and enhance their
understanding is with interactive book apps. With the Green Eggs and Ham app, for
example, students hear the book read aloud while viewing the text and can tap items
onscreen to hear and see the word for that object. Older students can use the
Shakespeare in Bits: Romeo and Juliet app to read, watch, and explore that play using
the built-in comprehension tools.

iPad and iPod touch offer additional tools to support reading—for example, students
can take notes with the Notes app while they listen or pause to look up something on
the Internet when they have a question.

When and Where in the World

You can support students’ study of history and social studies with the tools available
with iPad, iPod touch, and iTunes. The versatile resources in iTunes U give students an
opportunity to experience different periods of history or other locales. Students
studying American history can view films from the Library of Congress in iTunes U of the
Spanish-American War (actually made between 1898 and 1901 or of the streets of
Chicago in 1897) or listen to Richard Nixon’s Presidential tape recordings available from
America Public Media. They can create an interactive journal in Pages on a Mac that
includes the primary source videos, audio, and images and publish it as an ePub
document to share with other students and family members.

They can enrich their learning with interactive game apps such as National Geographic’s
GeoBee, The Oregon Trail, or Pearson’s World History, or find information with apps such
as History Maps of the World and The World Fact Book.

Mobile Math

No matter what their level of math, students will enjoy math learning with iPad and iPod
touch. These are versatile tools to support the learning of mathematics, personalize
students’ learning, and extend learning beyond the classroom. Students can present and
analyze data in spreadsheets with the Numbers app on iPad. They can also perform
calculations and check their work with the Calculator app in iPod touch or with
graphing and other calculators and conversion tools available for iPad and iPod touch.

They can reinforce their math skills with hundreds of engaging, interactive apps
available from the App Store. Math apps provide you with an easy way to customize
learning for particular students—you can include specific apps on a student’s iOS device
to support that student’s learning needs. Elementary school students can practice math
skills with the Math Bingo map, solve problems on a digital chalkboard with MathBoard
for iPad, and enhance basic skills with the Time, Money & Fractions app for iPad. Older
students can deepen their understanding of algebra with the activities and videos in the
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AlgebraPrep app by Pearson or challenge their critical thinking skills with NineGaps, a
Suduko-like game for building math skills.

iTunes U also offers many math-related resources, allowing students to learn math in
different ways. Some examples are videos about algebra and geometry from the
Paradise Valley Unified School District using the Arizona State Department of Education
IDEAL eLearning Platform and materials about area and perimeter (and much more)
from the Tennessee Department of Education, Study Partner-Math program.

A Deeper Look at Science

iOS devices can enrich teaching and learning of science at all grade levels with their
highly interactive and engaging interface and rich collection of science tools and
resources. Students can conduct scientific explorations using digital science tools, such
as PASCO probeware or the ProScope Mobile digital microscope used with apps on iPad
and iPod touch. With such investigations, students use real scientific tools and can
quickly collect large amounts of real-time data for analysis that they can later use in
their projects.

A broad array of valuable science resources is available for use with iPad and iPod touch,
such as The Elements—a visual exploration of elements in the periodic table, Solar Walk
—a 3D exploration of space, Frog Dissection for iPad, and the Biology textbook available
with the Inkling app. You can browse the Science category of iTunes U to find content
for the subject of scientific study, from examples of bird songs to video talks on physics
and soil composition.

For lab classes, you can create podcasts with lab experiment instructions that can
include narration, text, video, and photos for students to access at any time on a mobile
device. Students can then record findings with the Notes app and with Pages on iPad,
time data collection with the Lab Timer app, record their results with voice recordings,
take photos and videos of their explorations with the iPod touch camera, and compare
their results with images from similar experiments on the Internet.

Exploring Art and Music

iPad and iPod touch offer a wealth of opportunities for students to learn about and
produce art and music. They can create art on iPad and iPod touch with just their fingers
using exciting painting and drawing apps such as Doodle Buddy, Brushes, and
Sketchbook Mobile. They can add effects to and edit photos with apps such as TiltShift
Generator (for creating retro miniature pictures from photos), Camera Bag, and Adobe
Photoshop. Students can view art collections of the world via apps such as Love Art:
National Gallery of London and Musée du Louvre and download walkthroughs and talks
from iTunes U, such as from the Asian Art Museum, Museum of Modern Art, and
London’s Victoria and Albert Museum.

With the GarageBand app on iPad, students can play a wide variety of musical
instruments. Students can also create music using apps such as Band, Instruments!,
Pianist Pro, Violin Player, and Shiny Drum, all of which can be used with iPod touch as
well as iPad. Vocal performances can be recorded with GarageBand on iPad or Voice
Memos on iPod touch, or video of their performances can be captured with the built-in
camera on iPad or iPad touch and edited with the iMovie app. Apps such as Karajan
Beginner and resources from iTunes U are available for teaching music theory. And with
resources from iTunes U, students can learn how to compose and explore different types
of music, from Chicago Blues to Indian ragas.
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Enhancing Productivity for Educators

iPad, iPod touch, and iTunes provide educators with versatile tools for the school day
and beyond. Administrators and teachers, including resource specialists, can use voice
recording on iPod touch to record observations during classroom walkthroughs, and
then email those files to the teachers. You can record voice memos about students and
email them to students’ families.

With the apps on your iOS device, you can stay in touch using the Mail app, use Notes to
take notes at any time and then email them to others, keep track of your schedule with
the Calendar app, and create presentations and movies to show the class.

You can also choose from a large variety of apps to download to support your teaching.
Examples include:

Apps to access your school’s student information system, such as PowerTeacher Mobile

(for iPad) or Mobile SIS, for use with PowerSchool and StudentRadar for use with
RadarServer

Apps to work with web-based teaching and learning software, such as Blackboard
Mobile Learn, for use with Blackboard

Interactive polling apps such as ResponseWare and eClicker, with which students
respond to a presenter’s questions on the iOS device

Apps to track student attendance, assignments, and more, such as Schedule Tracker and
TeacherPal

Assessment tool apps, such as GradePad and Tango RX

There'’s never enough time in the day for educators, which is why using iPad and iPod
touch for professional development is such a great solution. The mobile nature of these
devices gives you the ability to review and reuse development materials when and
where it's most convenient. You can download professional development content to
your iPad or iPod touch and listen while you're at the gym, driving to and from work, or
doing chores at home. You can view videos of new directives and techniques without
waiting for the next face-to-face training session. And you can pause listening to take
notes, email an idea to a colleague, or look up additional information on the Internet—
all on your iOS device.

Podcasting allows administrators to update parents or faculty—even an entire district—
in minutes. With just a few clicks, professional development content can be delivered
automatically. It's the perfect way to expand ongoing training programs without
straining district resources (see “Producing Podcasts” earlier in this guide).

Many types of professional development content are available for iPad and iPod touch.
An abundance of free educational resources are available, including a wide variety of
lectures, discussions, and other materials from iTunes U as well as podcasts from the
iTunes Store and other sites. Commercial materials, such as books, are also available from
the iTunes Store and iBookstore. All of these resources can be synced to iPad and iPod
touch for convenient learning on the go. For example, you can check out these
professional development titles, all available free of charge from iTunes U:

Edutopia—Teacher Development

http://deimos3.apple.com/WebObjects/Core.woa/Browse/edutopia.org.
1648918858.01648918860
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+ Center for Teaching and Learning

« University of South Florida— Professional Development Resources

http://deimos3.apple.com/WebObjects/Core.woa/Browse/usf.edu.
1273012993.01273013001

« City University of New York Baruch College—Master Teacher Series

http://deimos3.apple.com/WebObjects/Core.woa/Browse/baruch-cuny-public.

1623324009.01623324014

43


http://itunes.apple.com/itunes-u/center-for-teaching-learning/id385634612
http://itunes.apple.com/itunes-u/center-for-teaching-learning/id385634612
http://deimos3.apple.com/WebObjects/Core.woa/Browse/usf.edu.1273012993.01273013001
http://deimos3.apple.com/WebObjects/Core.woa/Browse/usf.edu.1273012993.01273013001
http://deimos3.apple.com/WebObjects/Core.woa/Browse/usf.edu.1273012993.01273013001
http://deimos3.apple.com/WebObjects/Core.woa/Browse/usf.edu.1273012993.01273013001
http://deimos3.apple.com/WebObjects/Core.woa/Browse/baruch-cuny-public.1623324009.01623324014
http://deimos3.apple.com/WebObjects/Core.woa/Browse/baruch-cuny-public.1623324009.01623324014
http://deimos3.apple.com/WebObjects/Core.woa/Browse/baruch-cuny-public.1623324009.01623324014
http://deimos3.apple.com/WebObjects/Core.woa/Browse/baruch-cuny-public.1623324009.01623324014

Getting Started with Apple iOS Devices:
A guide for using iPad, iPod touch, and iTunes for K-12 teaching and learning

Resources

Apple Websites

You can visit various Apple websites to learn more about iPad, iPod touch, and iTunes. At

these sites, you will find tutorials, lesson plans, and many other valuable resources.

Learning with iPad
Information about iPad features, iTunes U, apps, and more

www.apple.com/education/ipad

Learning with iPod touch and iPhone
Information about iPod touch and iPhone features, iTunes U, apps, and more

www.apple.com/education/ipodtouch-iphone

Apps for Learning

Information about apps for mobile learning, organized by subject and function
www.apple.com/education/apps

App Collections on the App Store
Back to School for iPad

Apps For Kids

Language, Grammar, and Vocabulary Apps

Special Education for iPod and iPhone

Special Education for iPad

iTunes
Information about iTunes

www.apple.com/itunes/what-is

Article about syncing

http://support.apple.com/kb/HT1386

iPad

Tutorial and other information about features of iPad

www.apple.com/ipad

For support information and to download the iPad User Guide

www.apple.com/support/ipad
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iPod touch
Information about features of iPod touch

www.apple.com/ipodtouch

For support information and to download the iPod touch User Guide

www.apple.com/support/ipodtouch

iTunes Tutorials
Collection of video and text tutorials for iTunes

www.apple.com/itunes/how-to

Tutorial that provides everything you need to know about iTunes

www.apple.com/support/ipod101/tunes

iTunes U
Video about how to access iTunes U on your iPhone or iPod touch

www.apple.com/education/itunes u

iTunes U Collections

Ancient Greece and Rome

United States History & Politics

iTunes Support

The iTunes product support pages are packed with information to help you learn how
to use iTunes and to assist you with any questions you may have. The support resources
include all iOS devices’ manuals and information about system requirements and the
location of files. User discussions, articles, and the latest versions of iTunes updates can
be found here.

www.apple.com/support/itunes

Resources for Education
Includes getting started guides, school profiles, tutorials, and more

www.apple.com/education/resources

Accessibility

Accessibility features included with Mac OS X, iPhone, iPad, iPod, iTunes, and other
resources

www.apple.com/accessibility

iLife
Information about the iLife applications

www.apple.com/ilife

iLife Video Showcase

www.apple.com/ilife/findouthow
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Apple Professional Development

Apple Professional Development workshops are an effective way to get up to speed
quickly with your new classroom iPad and iPod touch devices. The Apple Professional
Development team delivers professional development tailored to meet your needs.
There are 15 onsite workshops available. Workshops such as “Mobile Devices,”“Language
Development,”“Podcasting,” and “Special Education” are just some of the offerings
available to help you integrate best classroom practices using iPad and iPod touch.

www.apple.com/education/professional-development

Additional Websites

iPod Deployment and Management website from an Apple Distinguished Educator

http://wiki.canby.k12.or.us/groups/ipodusergroup/wiki/471c6/
iPod Deployment _and Management.html

Apple Distinguished Educators present activities to support teachers in using apps to
improve student learning

Apptivities

Education Apps Review

www.iear.org

Wiki about using iPad in the classroom
Teach With Your iPad

iPad apps for teaching by a British Apple Distinguished educator
iPads in Education
iPad Academy site with training, tips, and tutorials

http://ipadacademy.com

Victoria, Australia government site about using iPad in education

http://ipad.ipadsforeducation.vic.edu.au

Accessories for iPad and iPod touch

Many types of helpful accessories are available to enhance the use of iPad and iPod
touch for teaching and learning. These include cables and connectors for connecting a
TV or projector to your iOS device, such as the Apple Digital AV Adapter or Apple VGA
Adapter for iPad or the Apple Component AV Cable, or Apple Composite AV Cable,
headphones with a microphone for recording, speakers, cases, power adapters, and
more. External speakers that connect to iPad or iPod touch or to a Mac are helpful when
you want to play back content from the device or a computer for the whole class to
hear. You can connect a document camera to an iPad or iPod touch to project an image
of the device’s screen to the class. Cases can come in handy if you plan to have students
take the devices outside of the classroom. Apple TV allows you to watch content in
iTunes or (with AirPlay included with iOS 4) on iPad or iPod touch. And with the Remote
app, you can even use the iPad or iPod touch to control Apple TV playback on your TV.

For details about accessories for iPad and iPod touch, visit www.apple.com/ipad/
accessories and www.apple.com/ipod/accessories.
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